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How to Reorder Pages in PDF and Delete PDF Pages

How to rearrange pages in PDF:


1. Open a PDF in PDFChef by Movavi.

2. In the top toolbar, click Manage Pages.

3. Reorder PDF pages – drag and drop them into place.

4. Delete the pages you don't need.

5. Save the edits.
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By clicking the download button, you're downloading a trial version of the program.*
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How to organize PDF pages
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A PDF document can be challenging to edit, but if you need to remove a page or reorganize the contents of a PDF, there are some methods that you can use. In this guide, we’re exploring how to remove pages from a PDF or organize PDF pages. For example, if you need to change the order of pages in a PDF document, it can be surprisingly tricky with certain software. This is such a mainstream file format, but Adobe® Reader® doesn’t allow you to easily make changes, so people are often looking for other methods to rearrange PDF pages. That’s where PDFChef comes in. There are different methods to use, and some don’t require you to download any software to edit or reorganize your PDF. You need to make sure you get to grips with reorganizing the pages so you don’t risk deleting something you still need.




How to rearrange pages in a PDF with PDFChef by Movavi



Step 1. Install PDFChef by Movavi


Download the PDFChef installation manager by clicking the Download button. Run the installation manager from the Downloads folder and follow the on-screen instructions to complete the installation.
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Step 2. Open a PDF


Run the program, click the Open File button, and choose the file you want to edit from the displayed list.








Step 3. Change the order of pages


The easiest way to do this is to use the Manage Pages mode. In this mode, you can move and reorder pages by simply dragging and dropping them into place.








Step 4. Renumber the pages


If the document is paginated, you may also need to renumber the pages after reordering them. To do this, go back to the main program window and hit the Edit button to start the process of renumbering the pages. You can change page numbers one by one by left-clicking on them and entering the new numbers.
You also can delete extra pages (if there are any). To do this, just select the page range using the mouse and the Ctrl or Shift keys and click Delete.








Step 5. Save the edits


To save the rearranged PDF as a new document on your computer, click File on the menu bar and select Save As. If you want to save the edits back into the source file, click File on the menu bar and select the Save option.








How to remove pages from a PDF



Step 1. Install the software


Click the Download button to download the PDFChef installation manager. Navigate to the downloaded file and run the installation manager. Follow the instructions provided on the screen.
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Step 2. Open your PDF file


After the installation is complete, launch the application. Click the Open File button and select the PDF document you want to process.








Step 3. Delete certain pages from the PDF


To delete multiple blank or other unwanted pages, switch to the page management mode using the Manage Pages button. Select the pages you want to delete by doing one of the following: hold down the Ctrl key and click on the desired pages to select multiple random pages; for multiple consecutive pages, hold down the Shift key (Cmd key for Mac users) while clicking on the first and last pages. Hit the Delete button in the right-hand panel.








Step 4. Save your file


After all the changes are complete, you can save your file using the Save or Save As commands from the File menu.








How to delete one page in a PDF



Step 1. Install the program


Download PDFChef by Movavi and double-click the downloaded file. Follow the on-screen instructions to install the program.




Download for Free
Download for Free

Download for Free
Download for Free





Step 2. Open your PDF document


Run the program and click Open File to add a PDF.








Step 3. Delete a page from the PDF


To remove a page from the PDF, find that page in the preview panel, right-click on it, and choose Delete from the context menu.








Step 4. Save your file


When you’re ready, save your edited file using the Save or Save As command on the File menu. That’s all there is to it! Now you know how to delete a page in a PDF.
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* The trial version of PDFChef by Movavi has the following restrictions: 7-day trial period, watermark on the output PDF. 






How to reorder and delete pages in PDF online


For those who prefer working online, we suggest PDFChef. This online tool also supports rearranging and deleting pages in PDF documents. However, note that the program cannot sort PDF pages, so you can only upload and move pages within a document.







Step 1. Go to the site


Follow the link below to go to the service’s website.
PDFChef official website







Step 2. Open a PDF


On the Web page that opens, open a PDF file for editing via the Choose Files button or drag and drop it into the workspace.








Step 3. Move pages


If you need to move a single page in a PDF document, locate that page in the preview panel, right-click on it, and drag-and-drop it to its new location.







You can also move multiple pages in one pass. If the pages are consecutive, press and hold the Shift key and select them by clicking on the first and last pages in the sequence. If the pages aren't consecutive, press and hold the Ctrl key (the Cmd key on Mac keyboards) and select the appropriate pages by clicking on each one. Then move all the selected pages by dragging and dropping them into place.








Step 4. Delete pages from your PDF


Select the page range to delete using the mouse and the Ctrl or Shift keys as described above. Click Delete.








Step 5. Save the edits


To save the edited file on your computer, click Save and Download.








How to delete and rearrange PDF pages on Mac


Mac users sometimes find their software choices a little bit more limited. There aren’t as many freeware programs created for Mac, for instance. PDFs are very mainstream, and all of the functionality you can get for Windows is available for Mac. Fortunately, for those who want to easily make changes to PDFs, including delete pages from a PDF document, PDFChef by Movavi has a Mac version. Just make sure you are downloading the Mac file format “DMG,” and you can follow the instructions to install and use PDFChef by Movavi. The software is intuitive and straightforward and allows you to do far more than just rearrange and delete pages. It can convert PDF files and will enable you to edit the documents in more detail.
A solution for a lot of Mac users is to use Preview. Unlike other software like Adobe® Acrobat®, Preview comes inbuilt with your Mac operating system. This is the software that will open images and a number of different file types on your Mac by default. The features are a little bit limited, but it does have the option to delete pages as required. Follow the steps below to learn how to delete pages from a PDF using Preview:







Step 1. Open the PDF


If you double click a PDF on your Mac, it will usually open with Preview. If another program is set as the default, you can right-click and select Open With. This will give you the option to use Preview.







Step 2. Navigate to thumbnails


In the View menu in Preview, you can navigate to Thumbnails. This will bring up a menu that has all of the pages of the PDF displayed as thumbnails.








Step 3. Select the pages to delete


Once in the thumbnail window, you can select which pages to delete. You can do this one at a time, but if you hold the Command key on your Mac, you can select multiple pages to delete. Clicking and dragging your mouse also works to select multiple pages.







Step 4. Delete and save as


Once you’ve chosen the pages you want to get rid of, you can click Edit on the top menu navigation and then Delete. This will delete these pages. If you then wish to save this as a new version, go to File and then Save As to save the updated file separately, with a new name.









How to delete and rearrange pages in PDF with Adobe® Reader®


A lot of people have downloaded Adobe® Reader®, and whether you are a Windows or a Mac user, you can use this software to read PDF files. However, it doesn’t have the inbuilt functionality to let you rearrange or delete the pages of a PDF. Instead, you need to use a different version of the Adobe® software. This is called Adobe® Acrobat®. Acrobat® isn’t free, so you will have to pay if you want to use this software. On the plus side, it has good flexibility and is relatively simple to use if you need to edit PDF files.
Below, we explore how to rearrange PDF pages and delete pages using Adobe® Acrobat®. Follow this step-by-step guide to ensure you delete only the pages you want to. Remember that you need to pay for this software, and this functionality is not available with the free Adobe® Reader®.







Step 1. Open the PDF in Adobe® Acrobat®


Make sure it doesn’t open in Adobe® Reader® by default. You can right-click and then select Open With and Adobe® Acrobat® to be sure.







Step 2. Show page thumbnails


On the left panel of controls, you will get an option for Page Thumbnails. If you don’t see it, on the main navigation menu, go to View and then Show/Hide. Page Thumbnails is found under the Navigation Panes menu. Turn this feature on.








Step 3. Rearrange pages if needed


If you want to rearrange pages, you can use drag and drop functionality to reorder the pages in the order you wish to. Simply click and drag the thumbnails, or, if you want to insert a new page, drag and drop this PDF into the thumbnails menu.
If you wish to copy a page, click the thumbnail and use Ctrl (Cmd on Mac) and drag to put it in a second location.







Step 4. Choose Any pages to delete


This can be done using click and drag, individually clicking pages, or holding the Ctrl key and selecting multiple pages. Mac users need to hold the Cmd key instead of Ctrl.








Step 5. Delete selected pages


Click the Delete button that is located on the very top of the Page Thumbnails pane. This will delete the pages that you have selected. Once you have finished rearranging and deleting certain pages, then it is possible to save the file as a new name. Click File and then Save As to give the file a new or incremental file name so that you can differentiate it from the original.








Frequently asked questions
How can I rearrange PDF pages for free?

How to rearrange pages in a PDF online for free:
	Go to the online PDFChef app.
PDFChef website
	Drag and drop your PDF file in the workspace.
	Move the pages around using drag and drop to change the order.
	Click Save and Download.




How do I delete pages from a PDF for free?

How to delete pages from PDF files online:
	Go to the online PDF page remover app.
PDFChef website
	Drag and drop your PDF file in the workspace.
	Select the unwanted pages and click Delete.
	Click Save and Download.



How do I add pages to a PDF?

Open PDFChef by Movavi → Add your files → Select the pages you want to add → Copy and paste the pages → Save the result
Read the full guide on how to add pages to PDFs:
How to add pages to a PDF





Similar guides
How to make a PDF       
How to complete a fillable PDF form       
How to open a PDF file       
Show More





Have questions?
If you can’t find the answer to your question, please feel free to contact our Support Team.
Visit Our Support Center
Visit Our Support Center

Watch Our Video Guides
Watch Our Video Guides
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